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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

Introduction

This guide is intended to take the user through the steps to needed run PFx (Processor-based
Functional Test or Processor-based Fast Programming) tests on a Zyng-7000 ZedBoard.

Software Setup

The computer needs one of the following products installed and licensed:

e ScanWorks® Processor-based Fast Programming for ARM 32-bit Processors
e ScanWorks® Processor-based Functional Test for ARM 32-bit Processors
e ScanWorks® Processor-based Functinal Test DDR for ARM 32-bit Processors

Hardware Setup

A computer is connected to a hub or switch via an Ethernet cable. A ScanWorks Remote
Instrumentation Controller (RIC-1000) is connected to the hub or switch via an Ethernet cable.
The Ethernet port on the ZedBoard is connected to the hub or switch via an Ethernet cable. The
RIC-1000 is connected to the ZedBoard’s JTAG port via a RIC-1000 UUT cable and an adapter
for the Zynq JTAG port.

1. Start ScanWorks.
2. Click on the Import Button.
oo JEIIR ST 0 R MR il = e

= Options | & Licenses || ?Help  [{C1=
Projects Status  Notes  Mappings  Reports

OIS PR ScanWorks loaded
+ Creats Import | & Projects [EnECWEUIAY
Manage 14 Licnse Check Out

Checked out: PFPT_ARM_ML_SUB

R P . Checked out: PFP_32ARM_DLSUB
ecent rO-JeCtS Checked out: PFT_32ARM_DLSUB

Checked out: PFT_DDR_32ARM_DLSUB

ScanWorks®

| eem—

SourcePoint ) ScanWorks®
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

3. Click on Browse and browse to the file to be imported —
C:\ScanWorks\Examples\PFx\ZedBoard Example Project.zip and clcik on Open.
W ScanWorks - - Se— -— - - o] (= E) ]|
Import a Project m e
1. Select the Import
File
Import File Browse
Select a compressed ScanWorks Project
Next
=
Yy Open u
O@R“ » Computer » Windows (C:) » Scanworks » Examples » PFx » v‘%“ Search PFx P|
Organize * New folder =~ 1 @
M Desktop “ Name : Date modified Type > Size
~» Recent Places p — - -
) Ml |E Zedboard_Example_Projectzip 3/28/2018 11:17 A..  zip Archive 4,829 KB|
& SkyDrive
= Libraries
_°L Documents =
. Music
1 Pictures
=. Subversion
i Videos
& Computer
& Windows (C)
& HP_RECOVERY (D ~ ¢ | i | »
File name: Zedboard_Example_Projectzip - lScanWorks Project (*zip) VI
I Open |VI l Cancel l

2ourcePoint Oy >canworks
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

4. Click on the Next Button.

Import a Project m © Back

2. Specify Name 3. Import

Import As Zedboard_Example_Project

Forbidden Characters: / 7\ *:|" > <.

Link Import to Source  [J Notify when project source changes

Destination Directory ~ C:\ScanWorks\Projects Browse

Nem

f— ]

5. Click on either Import Button.

: @ Back
Import a Project m
Zip File Source C:\Scanworks\Examples\PFx\Zedboard_Example_Project.zip
Project Name will be Zedboard_Example_Project
Link to Source? false
Import to C\ScanWorks\Projects

Ready to import

SourcePoint’ O ScanWorks’
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6.

A ScanWorks: Zed

Project: Zedboard_Fxample_Project
Design: Zedboard
Projects Actions

Designs Sequences

& Manage % Buld

Search: [Find Actions

Action Name -

Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

Type

Click on No Hardware to select the hardware controller.

No Hardware = Options

Status Notes Mappings Reports

“  Project Zedboard_Example_Project loaded
Loading Zedboard. Please wait...
Loading of design Zedboard complete

m DDR3 Test and Tune

LW Device Presence Tests - Ethernet Phy+Spi
Flash+MMC Card

m Ethernet Loopback Tests

m MMC Programming using Ethernet

m QSPLand MMC over JTAG+QSPI over
MMC

m QSPI Programming using Ethernet

[E=S—_—

Processor Functional
Test DDR

Processor Functional
Test

Processor Functional
Test

Processor Fast
Programming
Processor Fast
Programming
Processor Fast

Programming

& licenses | ?Help |

ScanWorks"

7.

Project: Zedboard Example Project
Design: Zedboard
Projects Actions

Designs Sequences

/& Manage % Build

Search: Find Actions

Action Name -

Select RIC-1000 as the controller.

No Hardware =% Options

Select a Controller

No Hardware -

Mappings Reports

\_ \—0\‘ tample_Project loaded

Type

Please wait...
PCI-410 idboard complete
PCle-410
PCle-1000
PXI-1000

m DDR3 Test and Tune

m Device Presence Tests - Ethernet Phy+Spi
Flash+MMC Card

m Ethernet Loopback Tests

ROLW MMC Programming using Ethernet

m QSPI and MMC over JTAG+QSPI over
MMC

m QSPI Programming using Ethernet

e—

Processor Functional
Test DDR

Processor Functional
Test

Processor Functional
Test

Processor Fast
Programming
Processor Fast
Programming
Processor Fast

Programming

RIC-1000

RIC-1000PODI

RIC-4000

& Licenses | ? Help .

ScanWorks®

SourcePoint”
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8. Configure the RIC-1000’s ip address, and select a TCK Frequency of 32 MHz. Note
that flash programming performance over JTAG is directly affected by the TCK
frequency. The higher the TCK Frequency, the better the programming performance.
Click OK.

-
Setup Hardware

Setup RIC-1000 Hardware

TCK Frequency (MHz): Delay Compensation: Cancel
[32000 ~] [o =

Help

el

TAP Voltage: IP Address:

|3.3 - I 192.168.12.119)

Discrete 10 TAP Voltages
Dizcrete 10 Signal 0 and 1:

[33 ~ |
Dizcete 10 Signal 2 and 3:

|33 |

Discrete 10 Signal 4 and 5:

|33 |

Digcrete 10 Signal 6 and 7

EE x|

9. Now let’s run the DDR3 Test and Tune Action from within Edit mode.

" ScanWorks: Zedl mple_Project.Zedboard

Project: Zedboard_Example_Project # RIC-1000 TS | Clemes | PRER [;]

TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119

Design: Zedboard

Compatible with Design? ves

Projects Designs Actions Sequences Status Notes Mappings Reports
/& Manage % Build ~  Project Zedboard_Example_Project loaded

Loading Zedboard. Please wait...
Loading of design Zedboard complete

Search: |Find Actions Loading of design Zedboard complete
Action Name “  Type
m DDR3 Test and Tune Processor Functional Test
DDR

Device Presence Tests - Ethernet

Phy+Spi Flash+MMC Card

Processor Functional Test

m Ethernet Loopback Tests Processor Functional Test

m MMC Programming using Ethernet Processor Fast
Programming

m QSPI and MMC over JTAG+QSPI over Processor Fast
MMC Programming

m QSPI Programming using Ethernet Processor Fast
Programming

m <pv Cran Dath Varifs v
ScanWorks®

e
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

10.  Right Click on DDR3 Test and Tune. This will launch the Development interface.

File Tools View Licensing

2 V105 Developer™ [3.0.14.2] (DDRS Test and Tune) h—_@ ?‘@g

Help

e [mn | [ psomeet]

Connected [VTOS DDR, Zyng-7000 Z-7020, SCANWORKS]

Project

= [3] Project:DDR3 Testand Tune
£ @ Connection Setings
{ o Faaures(T]
® <Add Fixture>
=% Tasks
-7 Task:VTOS DDR

® <Add Task>

Task
E % Configuration [VTOS DDR]
B e

oart
[ Board Iniialization
5 Scripts
=4 Processor [2-7020]
=8 DDR Settings
Board Specific Zyng7000
DDR3 Memory Part:micron_ddr3I_MT41K128M16-125
DR Tune
. DR PHY Training
& DDR Interactive Tests
~@@ DDR Walking 0 Test
) DDR Walking 1 Test
) DDR Address Test
) DDR Simultaneously Switching Output Test
) DDR Noise Burst Test
) DDR Noise Test
) DDR Full Burst Test
) DDR Full Byte Test

=-[ DDR Exported Tests
DDR Comprehensive Test
@ <Add Test

[ copy |[ Detete |[ up ][ Down |

Settings | Console

DUT ready
VTOS Zyng 7000 DDR Firmware
Version 03.03.077 (2018.03)

Project: C\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\DDR3 Test and Tune\DDR3 Test and Tune\DDR3 Test and Tune.project (Zyng-7000 Z-7020) [VTOS DDR]

PSR 7 7 Endramming. Notice that tey are ex

CONNECT DDR TFTP

11. Click on the Connect Button. This will download a target agent to the ZedBoard and

begin communicating with the target agent.

e — =T

‘@ VTOS Developer™ [3.0.14.2] (DDR3 Test and Tune)

= [ Project:DDR3 Testand Tune
& Connection Settings
L Fixtures[1]
® <Add Fixture>
S Tasks
2 Task:VTOS DDR

@ <Add Task>

Task
=g Configuration [VTOS DDR]
- Board Initialization
cripts
Processor [2-7020]
=42 DDR Setiings

Board Specific Zyng7000
m DDR3 Memory Part:micron_ddr3_MT41K128M16-125

) DDR Simultaneously Switching Ouiput Test
) DDR Noise Burst Test
) DDR Noise Test
® DDR Full Burst Test
@ DDR Full Byte Test
) DDR Full Word Test
) DDR Structural Test
) DDR Noise Group Test
) DDR Comprehensive Test
) DDR Constrained Random Test
) DDR Performance Test
DR Exported Tesls
@ DDR Comprehensive Test
® <Add Test>

[ copy |[ peete |[ up ][ pown |

General
Name

Stop On Failure
Normalize Files

Target

Load Firmware on Connect
Issue Target Version

Issue Reset on Disconnect
VTOS Runner

Logging Option

Use Timestamps

Run Option

Run Delay (ms)

Loop Option

Laop Stop Condition

File Tools View Licensing Help
[ras ][ comea : : |
Welcome! CONNECT DDR TFTP

[Project Settings | console

DDRS3 Test and Tune

True
True

False
False
False

Append
False

Stop on Failure
[

Loop Once

1

Name
Name of the selected item

Project: CAScanWorks\Projects\Zedboard_Example_Project\Zedboard\DDR2 Test and Tune\DDR3 Test and Tune\DDR3 Test and Tune,project (Zyng-7000 Z-7020) [VTOS DDR]

Elapse

Platform for Software Debug and Trace

ScanWorks’
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12.  You can manually run any of the tests in the DDR Interactive Tests group or the DDR

Tune Task by right clicking on it and selecting Run. Click on the Run Button near the
top of the window to run the test(s) that are in the DDR Exported Tests group.

@ VTOS Developer™ [3.0.14.2] (DDR3 Test and Tune)

) e | B

Help
=

File Tools View Licensing

“ Add

Done

CONNECT  DDR TFTP
Project settngs | Console
= [ Project:DDR3 Testand Tune 3
& Connection Settings

0 -> $ddr.tWLO // ddr_tWLO
43 Fixture:[1] —
® <Add Fixture> 160000 -> Sddr.tRFC // ddr tRFC
2% Tasks
[7) Task-VTOSDDR 7800000 —> $ddr. tREFT // ddr_tREFT
@ <Add Task>

$adr.rows // dar_rows
$aar.columns // ddr_columns
$aar banks // ddr_pan

Task

$ddr.bank_groups // ddr_bank_grou
=% Configuration [VTOS DDR]
e B

$aar.width // ddr_width

[ Board niialization

B2 Serpts

&% Processor [Z-7020] ddr. configure

etings ot e 2yn controlle

Board Specific Zyna7000 Conflouring Zynd PR Controll

= DDR3 Memory Part:micron_ddral MT41KI28M16-125

D

dar. timing. convert

= DDR Interactive Tests

DDR Simultaneously Switching Output Test
DDR Noise Burst Test

: g 0 (32
DDR Full Burst Test RAM Walkng v (3

1) (00000000 20000000)
Valking 1 (3
DDR Full Byte Test 91 (3

1t) [00000000_000000001
[00000000_00000000 ~ 00000000_1 £EEEEET]
(32-b1t) [00000000_DODOODOD - 00000000_1EEEEEEE]
Homory bus notse
DDR Noise Group Test rory ‘fs vl
DDR Comprehensive Test

e [00000000_000000001
[00000000_00000000 ~ 00000000_DOOEEEEE]
Fall (32 m 00000000_00000000 - 00000000_00OEEEEE
DDR Constained Random Test - 2o o !
DDR Performance Test

bit) [00300000_00000000 - 00000000_1EEEeeEe]

(burst) [00000000_00000000 - 00000000 _LEEEEEEE]
4, 0 Failed, 0 Aborted, Running tims 9.442
® DDR Comprehensive Test o
® <Add Test
[ copy J[ peete |[ up ][ pown |

Project: C\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\DDR3 Test and Tune\DDR3 Test and Tune\DDR3 Test and Tune.project (Zyng-7000 Z-7020)

) 1105 0wy

13. Add a test to the DDR Exported Tests group by right clicking on <4dd Test> beneath

DDR Comprehensive Test. Select DDR Performance Test from the list of tests. Then

hit File->Save to save the updated project. Hit the Run button at the top of the
interface.

@ VTOS Developer™ [3.0.14.2] (DDR3 Test and Tune)

o] =] El
File Tools View Licensing

“ Add

Help
=

Done

CONNECT ~ DDR TFIP
Project Settings | Console
=[] Project DDR3 Testand Tune
Connection Setings
'O Firture:{1]
® <Add Fidure>
2% Tasks
() Task-VTOSDDR
® <Add Task>

/7 adr_cotums

ddr. timing. convert,

adr . configure
Configuring Zyng DDR Controller

Configure CPU core clock
Task PU clock speed
=% Configuration [VT0S DDR] = o e R e, .
=l Board Configuring DDRIOB for DDRS
[ Board Iniialization configuration co
-4 Scipts s12 wiB
5 Processor Z-7021]
&4 DDR Settings

Board Specific Zyng7!

000 /7 DoR
mm DDR3 Memory Part:micron_ddr3_MT41K128M16-125

DR Interactive Tests

) ) £]
€ it) [D0DODOOD_0DBODDDO - D0DDOODO_IEEEEEEE]
bus noise [00000000_0000000]

DDR Walking 1 Test [00000000_00000000 — 00000000_OODEEEEE]

= Fall (52 bit) [0000000D_00000000 - 00000000 _OOOTEEET]
DDR Smufaneausly Sithing Output Test bit) [00G00000_00000000 — 0000000 1fEEEEEL]

oise Burst Test (burst) [00D00000_00OOOO00 - 0O0D0000 1FEFEEFEE]

DDR Noise Test 4, 0 Failed, 0

80F Contane Rardom s oo ssooms - oo oorieee
RE er\ d"?”fe est 3 k = 0.000 000 003, throughput
xporied Tests
4, 0 Failed, 0 Aborted, Rumning time 1.
DDR Comprehensive Test o
formance Test- Access Time

[ copy J[ peete |[ up ][ pown |

Project: C\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\DDR3 Test and Tune\DDR3 Test and Tune\DDR3 Test and Tune.project (Zyng-7000 Z-7020) [VTOS DDR] Elapsed: 00

Platform for Software Debug and T
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14. Close the Development window, and return to the ScanWorks Actions view. Click on
the Run Button to the left of DDR3 Test and Tune to run the DDR Exported Tests as

a ScanWorks Action.

] [ |

& ScanWorks: Zedboard_Example_Project.Zedboard

Project: Zedboard_Example_Project

Design: Zedboard
Projects Designs Actions
# Manage % Build

Action Name

Search: Find Actions

Sequences

Type

m DDR3 Test and Tune

# Edit €] Copy

» Run >_ Rename
© Delete

[l Reports

= Requirements
m Device Presence Tests - Ethernet
Phy+Spi Flash+MMC Card

m Ethernet Loopback Tests

m MMC Programming using Ethernet

m OSPT and MMC over ITAG+0OSPT aver

Processor Functional Test
DDR

Processor Functional Test

Processor Functional Test

Processor Fast

Programming

Draracenr Fact

T Options | @ Licenses  ? Help

4 RIC-1000
TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves

Status Notes Mappings

-» 8:108 | resp=""
-» Test passed; status=168

test.ddr.performance // DDR Performance Test - Access Time

SDRAM Performance Suite

SDRAM: cache read (32-bit) [{ -

FEFFF]

READS : average seck = ©.00@ 000 609, throughput = 412.914 MiB/s

SDRAM: cache write (32-bit) [ X - _000fFFff]
WRITES: average seek - 0.00@ 000 083, throughput - 905.989 MiB/s

Test Suite Totals: 2 Passed, @ Failed, @ Aborted, Running time 1.629

secs
-> 8:100 | resp=""
-> Test passed; status=168
Done.
Done!

Action passed!

e nn R

Run time: 20.761

ScanWorks'

15.

the Development interface for the Device Presence Tests.

Right Click on Device Presence Tests — Ethernet Phy+Spi Flash+MMC Card to enter

@ VTOS Developer™ [3.0.14.2] (Device Presence Tests - Ethernet Phy+Spi Flash+MMC Card)

=

File Tools View Licensing

Help

[ eas ][ comea fun || oscomet

‘ Welcome!

CONNECT PIN TP

fProject

Settings | Console

ject-Device Presence T ests - Ethermet Phy+Spi Flash-MMC Card
Connection Setiings
43 Fixture:[1]
® <Add Fiure>
% Tasks
2! Task VTOS Scan Plus
® <Add Task>

4 General
Name

Processor

Stop On Failure

Normalize Files

Target

Load Firmware on Connect

Issue Target Version
Issue Reset on Disconnect
4 VTOS Runner

Task

Logging Option

=% Configuration [VTOS Scan Plus]

[ Board nitislization
[ Pin Configuration
Scripts

: Processor [Z-7020]

<! Ethemet Group

HYs
® Ethemet PHY Exists Test
@ Ethemet PHY Verify Test
@ <Add Test>
< GPIO Group
GPIOD
~ GPIOT
GPIO2
GPIO3
12C Group
~ 1200

~ 12C1
Pl Group
SPID
SPIT
SPI
@ SPIFlash Device Exists Test
© SPIFlash Verify Test

Use Timestamps
i Run Option

Run Delay (ms)
Loop Option

Loop Stop Condition

I

Device Presence Tests - Ethernet Phy-+Spi Flash +MMC Card
Zynq-7000 Z-7020

True

True

False
False
False

Append
False

Stop on Failure
[

Loop Once

1

Name
Name of the selected item

® <Add Test>
</ SD/MMC/SDIO Group
= SOMMCO -

‘ Project: C\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\Device Presence Tests - Ethernet Phy+Spi Flash+MMC Card\Device Presence Tests - Ethernet Phy+Spi Flash

ScanWorks’

Platform for Embedded Instruments

SourcePoint”
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16. This action checks for the presence of the Ethernet Phy, The flash device on the QSPI
port, and the presence of the MMC device. Hit the Connect button, then the Run
button.

@ VTOS Developer™ [3.0.14.2] (Device Presence Tests - Ethernet Phy+Spi Flash+MMC Card) ] (= [E ]
file Tools View Licensing Help
“ Add e Run || Disconnect ‘

Done CONNECT PN TP

Project Settings| Console

=[] Project:Device Presence Tests - Ethemet Phy+Spi Flash+MMC Card
=& Connection Setings

'O Fixture:{1]
® <Add Fixture> e 3 £\ e Pre e - Ethernet Phy+!
=% Tasks e 13 ect\ze: e P Tests - Ethernet Phy

2] Task VTOS Scan Plus
® <Add Task>

// Bthernet PHY Test(0, 0)

0 PHY ID High-0x0141 PHY ID Low=0x0DD1
Task

5% Configuration [VTOS Scan Plus] - ene _test // Ethernet PHY Verify Test(id high—0x0141, id_low=0x0DD1)
e T

[ Board hniialization erne H ID High=0x0141 PHY ID Low=0x0DD1
[ Pin Configuration pA

i+ Scripts

14 Processor [Z-7020] e evice Ex st (2, 0, 1000000, -1, -1)
=€ Ethemet Group e -

m

s
Ethemet PHY Exists Test

<Add Test> x19 True ¥ erify.test // SPI Flash Verify Test (2, 0, Ox01, Ox
< GPIO Group 3
~ GPIOO
=~ GPIO1

m

~ GPIO2

Set Bus Width (bus=0, width=1)

BhBEED

2, 0x544D): SD/MMC Device Ex Test (channel=0, manufacturer-id=0, oem-id=0, bl{

N

t (channel=0, manufacturer-id=0x02, oem-id=0x544D, blocks=

&</ SD/MMC/SDIO Group
£l SDMMCO

[ copy J[ peete |[ up ][ Down |

Project: C:\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\Device Presence Tests - Ethernet Phy-+Spi Flash+MMC Card\Device Presence Tests - Ethernet Phy+Spi Flash+ [ EE S N RN - U

17. If the SD/MMC Verify test fails, the most likely cause is the SD/MMC card in your
ZedBoard is a different make/model than the one used when creating this guide. To
update the settings for your SD Card, click on SD/MMC Verify test and then change
the Manufacturer ID, OEM ID and size fields to match your SD card. Note that the
size of the SD/MMC card is printed out in decimal in the test, but the input field is
expecting a hexadecimal entry. Save the Project. Hit the Run button to verify the
change in settings have corrected the problem.

@ VT0S Developer™ [3.0.14.2] (Device Presence Tests - Ethernet Phy+Spi Flash+MMC Card) ] =[5

File Tools View Licensing Help

[ e |

Done CONNECT PIN TFTP

Project Settings | Console
=[5 Project Device Presence Tests - Ethemet Phy+Spi Flash-MMC Card 4 General
= @ Connection Settings Name
© Fixure:(1] e
® <Add Fiure> Actions S
5% Tas Setup Actions <Add Actions>
] Task'VTOS Scan Plus Cleanup Actions <Add Actions>
® <Add Task>

| 002
0x544D
Capadity 0x0075C000

Task

& Processor [2-7020] B
5< Etemet Group
HYs
@ Ethemet PHY Exists Test
® Ethemet PHY Veriy Test
@ <Add Test>
£-< GPIO Group
- GPIOD

2
2

2
208

Manufacturer Id
@ SPI Flash Device Exists Test The 8-bit expected manufacturer ID returned by the SD/MMC device in the Card Identification register (CID).

@ SPIFlash Verfy Test
® <Add Tese

=< SD/MMC/SDIO Group
MMCO
@ SD/MMC Device Exists Test:SDMMC (0x02, 0x544D)
® SOIMMC Verify Test
® <Add Test>
i) ~ SOMMC1
=< UART Group .

([copr] [Loseter) (e (oo,

Project: CAScanWorks\Projects\Zedboard_Example_Project\Zedboard\Device Presence Tests - Etheret Phy+Spi Flash+MMC Card\Device Presence Tests - Ethernet Phy+Spi Flash - | BT IS R RTIEN

O ScanWorks®

Platform for Embedded Instruments
11
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18. Close the Development window, and return to the ScanWorks Actions view. Click on

the Run Button to the left of Device Presence Tests — Ethernet Phy+Spi Flash+MMC

Card to run the Device Presence Tests as a ScanWorks Action.

& ScanWorks: Zedboard_Example_Project.Zedboard

Project: Zedboard_Example_Project

Design: Zedboard
Projects Designs Actions
Lge Gl F Manage €5 Build

Action Name

Search: |Find Action

Sequences

Type

DDR3 Test and Tune

m Device Presence Tests - Ethernet
Phy+Spi Flash+MMC Card

# Edit ) Copy

» Run »_ Rename
© Delete

[l Reports

= Requirements

LU Fthernet Loopback Tests

m MMC Programming using Ethernet

Processor Functional Test
DDR

Processor Functional Test

Processor Functional Test

Processor Fast

Programming

] (|5 Sl

F RIC-1000 I Options @ Licenses | ? Help _L
TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves
Status MNotes Mappings Reports Pa Ssed

SD/MMC Device Exists Test
SDSMMC: Channel=@8 Manufacturer TD=-8x@2 OEM TD-8x544D Size-7716864
-» B:188 | resp=""
-» Test passed; s5Tatus=188
8 Bx@2 8x544D Ox0875C008 TRUE sdmmc.verify.test // SD/MMC Verify Tes
t{channel=8, manufacturer-id=0x82, cem-id=@8x544D, blocks=8x8075(008, ve
rify=TRUE)
SD/MMC Device Verify Test
SD/MMC: Channel-@ Manufacturer ID-9x@2 OEM ID-0x544D Size-7716864
-» B:188 | respa"’
-» Test passed; status=188
Done.
Donel
Action passed!
TSR

S

Run time: 9.142

ScanWorks'

19.

for the Ethernet Loopback Tests.

Right click on the Ethernet Loopback Tests action to open the Development interface

@ VT0S Developer™ [3.0.14.2] (Ethemet Loopback Tests) o] o [ ) [
File Tools View Licensing Help
[Ceea J[comea ][ mn [ oscomea \
‘ Welcome! CONNECT PN TFTP ‘ ‘
(Project’ Settings | Console
=17 Project:Ethemet Loopback Tests 4 General
@ Connection Setings Name Ethernet Loopback Tests
8 :";:Fg”y Processor Zynq-7000 27020
£ % Tasks Stop On Failure True
7] Task:VTOS Scan Ethemet Normalize Files True
® <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False
4 VTOS Runner
Task Logging Option Append
Fal:
% Configuration [VTOS Scan Ethemet] Use Timestamps alse
£l Board Run Option Stop on Failure
[ Board nitialization Run Delay (ms) 0
8 P Conguron Loop Option Loop Once
ci
Processor [2-7020] Loop Stop Condition 1
E-< Ethemet Group
HYs
® Ethemet PHY Exists Test
@ Ethemet PHY Verify Test
@ <Add Test>
&
® Ethemet MAC Loopback Test:10 Mbps
@ Ethemet MAC Loopback Test:100 Mbps.
® Ethemet MAC Loopback Test:1000 Mbps
@ Ethemet PHY Loopback Test- 10 Mbps.
@ Ethemet PHY Loopback Test- 100 Mbps D
@ E]':‘;";‘?';ZV Loopback Test- 1000 Mbps Name of the selected item
~ GEM1

‘ Project: C:\ScanWorks\Projects\Zedboard_Example_Project!

Loopback

Loopback

Loopback Testsproject (Zyng-7000 Z-7020)

SourcePoint”

Platform for Software Debug and Trace

ScanWorks’
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

This action tests for the presence of the Ethernet Phy, does loopback tests on the

20.
ethernet MAC and loopback tests on the ethernet phy. Click on Connect and then on

Run.
o 1= B %

@ VTOS Developer™ [3.0.14.2] (Ethernet Loopback Tests)
Help

File Tools View Licensing

Disconnect
CONNECT PIN TFTP

Add e Run

Done
Project Settings| Console
=[] Project:Ethemet Loopback Tests [PASSED]
Cannection Seftings
“CF Fixture:{1] 0 #ENET.RGMIT enet.mii. (ethernet_1
® <Add Fixture>
5% Tasks 0 0 0 enet.phy.set.ext // Set PHY (ethernet_id=0, mdio_index=0, phy_address
& TaskcVT0S Scan Ethemet 0 #ENET.LB.MAC 10 FALSE 6 t.loopback. test // Ethernet MAC Loopback Test (0
.LB.MAC SE 64 enet.loopback. tes: rernet MAC Loopback Test (0,
® >
© <Add Task 't Packet MAC loopback
ccessfully, received packet comnt 64

4 enet.loopback.test // Ethernet MAC Lo

loopback
sfully, received packet count 64

Task

=% Configuration [VTOS Scan Etheme(]
2] ck.test // Ethernet MAC Loopback Test(0, 1000, 68)
[ Board Initialization back
[ Pin Configuration k ully, received packet count 64
F 5 Scripts
£ Processor [2-7020]
=-<! Ethemet Group . <E & loopback. test // Ethernet PHY Loopback Test - 10 Mp
- sback, 10 Mb
-@ Etheret PHY Exists Test n ical interface (PHYD)
) Ethernet PHY Verity Test waiting for link to come up on PHYD
@ <Add Test ully, rece cket count 64
=} GEMD
) Ethernet MAC Loopback Test:10 Mbps
) Ethernet MAC Loopback Test:100 Mbps . ¢ 3 st // Ethernet PEY Loopback Test - 100 Mb
® EthernetMAC Loopback Test:1000 Mbps n T
® Ethemet PHY Loapback Test-10Mbps : initializi ical interface (PHYD)
@ Ethemet PHY Loopback Test- 100 Mbps waiting for link to come Gp on PHYD
@ Ethemet PHY Loopback Test- 1000 Mbps k tes ully, receiv cket count 64
@ <Add Test
= GEMI
_PHY 1000 FALSE // Ethernet PHY Loopback Test - 1000 Mbps (0, 1000,

on PHYO

waiting for link to come m
cket count 64

eted ully, receiwe

[ copy |[ Deete |[ up ][ Down |
Project: C\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\Ethernet Loopback Tests\Ethernet Loopback Tests\Ethernet Loopback Tests.project (Zyng-7000 Z-7020) (VT B S HC R N

Close the Development window, and return to the ScanWorks Actions view. Click on
the Run Button to the left of Ethernet Loopback Tests to run the Ethernet Loopback

Tests as a ScanWorks Action.

21.

e

ptions | & Licenses = ? Help

& ScanWorks: Zedboard_Example_ProjectZedboard

Project: Zedboard_Example_Project & RIC-1000
Desig n: Zedboard TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119

Compatible with Design? ves

Reports Passed

Status Notes Mappings

Projects Designs Actions Sequences

Loopback test completed successfully, received packet count

#Manage  # Build

-> 8:180 | resp-

Search: -> Test passed; statu
) 000 FALSE 64 enet.loopback.test // Ethernet PHY Loop

back Test - 1000 Mbps(0, 1000, 64)

Action Name “ Type
Ethernet Packet Test: PHY loopback, 1008 Mbps

Processor Functional Test geme: initializing physical interface (PHV@)

m DDR3 Test and Tune
DDR timeout (5000 ms) waiting for link to come up on PHY@

Loopback test completed successfully, received packet count

m Device Presence Tests - Ethernet
Processor Functional Test

Phy+Spi Flash+MMC Card

m Ethernet Loopback Tests 7 enen [ rese

-> Test passed; status=
# Edit €21 Copy D
- o= e Processor Functional Test Done!
© Delete Action passed!

Reports

= Requirements
Processor Fast

m MMC Programming using Ethernet
Programming v
ScanWorks'

ScanWorks’

Platform for Embedded Instruments
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

22.  Right click on QSPI Programming using Ethernet to open Development interface for
the QSPI using Ethernet action. This action tests for the presence of a flash memory
device on the QSPI port, Erases the flash, does a blank check on the flash, Programs
the flash with a test file over Ethernet, and then tests the checksum of the range of

flash memory that was programmed.

@ V105 Developer™ [30.14.2] (5P Progeamming using Ethemet) =| =8 ®

Fila Tools View Licansing Help

s Connet

CONNECT Py T LS

Wielcome!

<hdd scficnz
«add acticnz

True
atrn

RGME (Reduced Gigabit M)
a

001EC300:00:00

192,168.12.204

255,255.255.0

192,168.12.228 -
<Edits

TFTP Server 1P Addresz
T runing the TFTP Server, Tvs coud be ts computer of arather network compules, The defaull ist s proviied bassd on IP Addresses for Lis comouter, Invaid values
wil nat: b saved

Praject: CA\ScanWorks\Projects\Zedboard_Exzmple_Proj

QSPT Programming using EthernetyQSPl iing wsing FicmetQSFl ing wsing Ethemetproject. Zyna- 7000 7-7023) [¥TCS Program SP1 Ethe | TR ]

23. To use the ethernet port on the UUT as the data pipe, the ethernet on the UUT must
be configured, and a TFTP client must be configured. Click on TFTP Server under
the Task tab to configure the UUT’s ipaddress and the TFTP client settings. Clicking
on the pull down to the right side of TFTP Server Address will show a list of
available addresses to use. Use the ipaddress of your computer as the ipaddress of the

TFTP Server.

@ VTOS Developer™ [3.0.14.2] (QSPI Programming using Ethernet) ] lE e
File Tools View Licensing Help
|
o] = o !
n Welcome! CONNECT AN TFIP FLasH
|
(Project]|
=/ [3) Project:QSPI Programming using Ethernet
(3 Connection Setings
O Fixture{1]
@ <Add Fixtu
=% Tasks "
£/ Task:VTOS Program SPIEthemet "
® <Add Task>
False
False
False
Task Append
5% Configuration [VTOS Program SPI Ethemel] False
2 e Boar Stop on Failure
o
Loop O
Loop Stop Condition 1
1 i
Using TFTP:QSPI 1 MiB
cksum Test:QSPI 1MiB x""‘ e sl
eration> lame of the selected item
Project: C: dboard_Example_Proj dboard\QSPI using Ethermet\QSPL using Ethernet\QSPI g Elapsed: 000:00:00:000

SourcePoint’

Platform for Software Debug and Trace
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

24.  Now configure the ipaddress of the UUT by entering the desired value in the field to

the right of Target IP Address. The appropriate subnet mask will be calculated and
entered automatically. Save the project.

@ V105 Developer™ [3.0.14.2] Q5 Programmng using Ethemet)

File Tools View Licensing

fdd

<add acticess
<add actizess

True
Mo

REAH (Reduced Glgabie M)
o

O01E:C2:00-08:00

Target IP Address
P —

ooy Deste w Down

Broject: CAScanWorks\Projectsi Zedboard_Example Broject| Zedboard\ Q58] Brogramming Lsing Ethemet\(SPI Brogramming using Ethemet\(}SP] Programming using Ethemet project (Zyng-/000 £-7120) (V105 Srogram SP1 Etnern

25.  Now that the TFTP Server is configured, The TFTP Server needs to be started. From
the top memu bar of the Development interface, Use the Tools pulldown and select
Tools-> Start TFTP Server. Note that the TFTP Server continues to run until it
stopped via Tools->Stop TFTP Server or the computer is shut down. You can tell the

TFTP Server is running when TFTP is shown in green in the upper right hand corner
of the Development Interface.

@ V105 Developer™ [3.0.14.2] Q5P Programming using Ethemet]

File Tools View Licensing
ara | canne: "

TFTP Server is running.

Frojact

ooy Dasie Vo Down

BTjart: CASCINWONS| Projects, Zernoar_EXample Project ZedboardyQse] rogrammming LSIng EMAMAt (P Pragramming using Ememen (Sel Pragrsmming using EMSmet projact (2yaq-/00 £-1020) (V105 ragram el mern [ SR ERTRaEY

L © ScanWorks®
Platform for Software Debug and Trace
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26.

@ VTOS Developer™ [3.0.14.2] (QSPI Programming using Ethernet)

Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

Click on Connect and then click on Run.

2] | | 5D e
File Tools View Licensing Help
\ had R Disconnet \
= CONNECT PN TFTP FLASH
Project

] Project:QSP| Programming using Eemet
2@ Connection Setings
0 Faxure: (1]
® <Add Fixture>
T Tasks
Task:VTOS Program SPIEthemet

® <Add Task>

Task
5% Configuration [VTOS Program SPI Ethems]
S B
0 Board Initialization
[ Pin Configuration
P Sciipls
®
1§ TFTP Server
=4 Program Operations
® Image Erase Test:QSPI 1MB
© mage Blank TestQSPI 1Mi8
® Program From File Using TFTP:QSPI 1 MiB
® Image Checksum Test:SPI M8
@ <Add Operation>
Copy | [ Delete Up Down

Project: C:\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\QSPI

using Eth

Settings | Console

7000 ProgramsPIEthernet Firmware

03.077 (2018.03)
£ 13:21:48

aWorks\Brojes

\pr
s\proj

up drop // Set the CPU Cl.
9 (799 Maz

201
[eAssED]

#ENET.RGMII 0 ' 00:11

\Zedboard\QSPI Programming using Etl
board\QsP:

Programming using Etl
T Programming using Ether

rnet\ps7_init,
Programming using Ether

Tnet\QSPT
£\ \ps7_in,

Speed to 800 MEz

MEz)

-1 100000000 50000000 0x01000000
ial (SPI) NOR Flash Discovery Tes

0000100 5 3000 serial flash.configure // SPI Flash Install (9S

204 1p/255.255.255.0 ip/192 1p/10.10.10.1  tftp.server.config

QSPI' 0x0000000000000000:64 ' C:\Scanworks\Projects\Zedboard_Example_Project\Zedboard\QSPI Programming using Ethernet\QSPI Programming using Ethernet\la|
Progran device with file

g to server 1
: receiving file

* QSPI' 0x0000000000000000: 6
© MDSSUM Verify T

2\QSPL

0x0000000000100000:64 =

t: start offset 0x0 0x0, byte count OO 0x100000
PI' mdS-aa26EE5bE95I5EbOEEC

ntents using TET

9 2.228.
'C:\SeanMorks\Projects\:

dboard\QSPI Programming nsing Ethernet\QSPI Programming Programmed from TETE 0x000000(

aa26££50895356boLEC .test // Image Checksum Test (QSPI)

2920a9£89e66

27.

using Ethemet\QSPI

using Ethemet.project (Zyng-7000 Z-7020) [VTOS Program SPI Ethern

In the example above, the flash memory was programmed at a rate of 749

KiB/second. Close the Developement interface, and click on the Run button to the left
of QSPI Programming using Ethernet to run the action from ScanWorks.

% ScanWorks: Zedboard_Example_Project Zedboard

=] [=lE e

Project: Zedboard_Example_Project

Design: Zedboard

Designs Actions
| #Manage 4 Build
Search

Action Name

a

Sequences

Type

m DDR3 Test and Tune

m Device Presence Tests - Ethernet
Phy+Spi Flash+MMC Card

m Ethernet Loopback Tests
m MMC Programming using Ethernet

m QSPIand MMC over JTAG+QSPI over

MMC
m QSPI Programming using Ethernet
# Edit ] Copy

Processor Functional Test
DDR

Processor Functional Test

Processor Functional Test
Processor Fast
Programming
Processor Fast

Programming

Dracacenr Eact

#~ RIC-1000
TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves

Options & Licenses | ? Help

Status No

Passed

Mappings Reports

Programmed from TFTP ©x0800

_00100800 byte:

onds, throughput of 758

-> 8:180 | resp-'"

-> Test passed; statu

s' QSPT

166000:

s' aa26ff5b8953

S6bcFFd9202ba0f89e66° TRUE imagesd.

/ Image Checksum Test(QSP

9]
QSPI: MDSSUM Verify Test: start offset byte count 8x8 @x1.
"QSPI" md5=aa26f: 6bcffd9292badfesess
-> 8:180 | resp-''
-> Test passed; statu
Done.
Done!
Action passed!

Run time: 28.657

ScanWorks®

Platform for Software Debug and T
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

28.  Right click on the MMC Programming using Ethernet to open the Development
interface for the MMC Programming action.

@ VTOS Developer™ [3.0.14.2] (MMC Programming using Ethernet) [ o= | s
File Tools View Licensing Help
[ zaa ] ["comea
‘ Welcome! g TP F
[Praeet Settings | console|
= ProjectMMC Programming using Ethernet “ General
- @ Connecton Setings Name MMC Programming using Ethernet
O Foxure: 1] e ;
® <Add Fixture> - o -
% Tasks Stop On Failure True
2] Task:VTOS Program MMC Ethernet Normalize Files True
@ <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False
4 VTOS Runner
Task Logging Option Append
Use Timestamps False
=% Configuration [VTOS Program MMC Ethemet] -
£ I Board Run Option Stop on Failure
] Board hiialization Run Delay (ms
g Pin Configuration Loop Option Loop Once
rocessor [2-7020] Loop Stop Condition 1
SD/MMC/SDIO Group
SDMMCO
 SD/MMC:SDMMC 1:1
® <AddDevice>
1~ SDMMC1
& TFTP Server
# Program Operations
Image Erase Test:1 M8
® Image Blank Test:1MB
® Program From File Using TFTP:1MiB
® Image Checksum Test:1 MB Name

® <Add Operation> Name of the selected item

Copy. Delete. Up Down

Project: CAScanWorks\Projects\Zedboard_Example_Project using using using Ethemet.pr [ EETEEITY 660

29. This action tests for the presence of the SD/MMC card, erases a portion, performs a
blank check on the portion, programs the SD/MMC card with a file using the ethernet
as the data pipe, and runs a checksum on the portion programmed. Configure the
TFTP ipaddresses as shown in the QSPI Programming using Ethernet TFTP Server
setup. Save the Project. Note that the TFTP Server does not have to be started again.
Click on Connect and Run.

@ VTOS Developer™ [3.0.14.2] (MMC Programming using Ethernet) &\ [
File Tools View Licensing Help
[ | ‘
Done CONNECT PIN TFTP FLASH

Project Settings | Console

=] Project:MMC Programming using Ethernet
£ @ Connection Setings
{ o Faaures(T]
| ® <Add Fidure>
=% Tasks
-.[¥) Task:VTOS Program MMC Ethemet
® <Add Task>

0x0000000000100000:64 s' a: 5b895356bcfEdY: 19F TRUE image64.md5.test // Image
X60000000, byte count 0x0 0x100000

ing Ethernet\MMC Programming using E:
ng Ethernet\MMC Programming using Ethernet)

Task
E % Configuration [VTOS Program MMC Ethemet] D // Set the CPU Clock Speed to 800 Mz
=-- k 2 Hz (799 MHz
[] Board Initialization
Pin Configuration Lwidth. & Bus Width 0, width-4)
& Scripts

Processor [Z-7020] : Linstall drop // SD/MMC Install(SDMMC 1:1)
< SDIMMG/SDIO Group
£ SDMMCD
® SD/MMC::SDMMC 1:1 * 0x0000000080000000:64 0x0000000000100000: 64 image64.crase.test // Image ETase Test(SDMMC 1:1)
® <Add Device> v
- SDMMCT
-ty TFTP Server
= & Program Operations :1' 0x0000000080000000: 64 0x0000000000100000: 64 image4.blank.test // Inage Blank Test(SDMMC 1:1)
© Image Erase Test:1 MB Slank test
Image Blank Test:1 Mig
Program From File Using TFTP:1 MiB
@ Image Checksum Test:1 MiB i . 64 s' C:\ScanWorks\Projec board Example Project\Zedboard\MMC Programming using Ethe
@ <Add Operation> »

s\Projects\zedboard_Example_Project\Zedboard\MMC Programming using Ethernet\MMC Programming

TRUE image64.mds.test // Image

[ copy |[ Detete |[ up ][ Down |

Project: CAScanWorks\Projects\Zedboard_Example_Project\Zedboard\MMC Programming using Ethemet\MMC Programming using Ethemet\MMC Programming using Ethernet.or [ BT R EIOR

O ScanWorks®

Platform for Embedded Instruments
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30.

Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

Note that in the example above, the SD/MMC card was programmed at a rate of 1.03

MiB/second. Close the Development injterface, and click on the Run button to the left
of MMC Programming using Ethernet.

A ScanWorks: Zedboard_Example_Project.Zedboard

e (= |

Project: Zedboard_Example_Project
Design: Zedboard

Projects Designs Actions

#Manage | %2 Build

Action Name

Sequences

Search: Find Actions

a

Type

m DDR3 Test and Tune

m Device Presence Tests - Ethernet
Phy+Spi Flash+MMC Card

m Ethernet Loopback Tests

m MMC Programming using Ethernet

# Edit 2] Copy

» Run >_ Rename
© Delete

[al Reports

= Requirements

Processor Functional Test
DDR

Processor Functional Test

Processor Functional Test

Processor Fast

Programming

m OSPT and MMC aver ITAG+OSPT aver  Praracenr Fact

& RIC-1000
TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119
Compatible with Design? ves

Status Notes

Mappings

onds, throughput of 976.011 KiB/s

> :160 | resp-'"

-> Test passed; status=10@

X Options

Reports

& Licenses || ?Help | ¢

s' SDMMC 1:1'

bBO5356bcFFd202ba0F80e66' TRUE imagebd.mdS.test // Image Checksum Tes

T(SDMMC 1:1)
SDMMC 1:1: MDSSUM Verify Test
xe x100000

Device="SDMMC 1:1°

> 0:100 | resps'’
-> Test passed; status=100

Done..

Done!

Action passed!

64

start offset @xe 8x30000000,

md5-2226F5b805356bcFFd9202b20FBO66

100000:64 5 aa26ffs

byte count

s

Run time: 22.23

ScanWorks’

31.

Development interface for the programming action.

Right click on the QSPI and MMC over JTAG+MMC over QSPI to open the

’ VTOS Developer™ [3.0.14.2] (QSPI and MMC over JTAG+QSPI over MMC)

&Jﬁ@ﬂ‘

® <Add Device
(- SDJMMC/SDIO Group
(£~ SDM

n

® SD/MMC::SDMMC 11
@ <Add Device>
~ SDMMC1
(=4 Program Operations
@ Image Erase Test:SP| Flash
@ Image Blank Test:SPI Flash
@ Program From File-SPI Flash
@ Image Checksum Test:SPIFlash
® Image Erase Test:SD Card
® Image Blank Test:SD Card
@ Program From File:SD Card
@ Image Checksum Test:SD Card b
@ Image Erase Test:QSPIto MMC

File Tools View Licensing Help
“ Add ] [ Connect Run Disconnect ‘
‘ Welcome! CONNECT PIN TFTP FLASH ‘ ‘
{ Project]] Settings | Console

=[5 Project:QSP and MMC over JTAG+QSP! aver MMC 4 General

7 onnection Setings Name QSPIand MMC over JTAG + QSPI over MMC
O3 Fixture:{1] i
® <Add Fixture> Processor 2ynq-7000 27020
&% Tasks Stop On Failure True
£] Task:VTOS Program SPIMMC Normalize Files True
® <Add Task> 4 Target
Load Firmware on Connect False
Issue Target Version False
Issue Reset on Disconnect False
4 VTOS Runner
Task Logging Option Append
i Fal
% Configuration [VTOS Program SPIMMC] ~ Use sl
- il Run Option Stop on Failure
O Board Initialization Run Delay (ms) 0
[ Pin Configuration Loop Option Loop Once
rocessor [Z-7020] Loop Stop Condition 1
| Group
SPi0
SPit
aspl
© SPIFlash:S25FLI56SAGNFIO

Name
Name of the selected item

o) (oo | e oo ]

Project: C\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\QSPI and MMC over JTAG +QSPI over MMC\QSPI and MMC over JTAG+QSPI over MMC\QSPI and MMC over

Elapsed: 000:00:00:000
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

32. This action shows other capabilities of PFx. In this action, the Flash on the QSPI is
tested for presence, the presence of the SD/MMC card is tested, the Flash is erased, a
blank check is run on the flash, the flash is programmed over the JTAG port (useful if
your UUT does not have an ethernet port) and the checksum test is run. The
SD/MMC card is erased, blank checked, programmed via the JTAG port and the
checksum is tested. After that is an example of programming the SD/MMC card using
the flash on the QSPI port as the data source (device to device programming). Click
on Connect and then Run.

@ VTOS Developer™ [3.0.14.2] (6) PFP3) ] i [ ) o)

Help

File Tools View Licensing

” add | | mn || pisconneat ‘
L

Done CONNECT PIN TFTP FLASH

Project Settings | Console

= [3 Project:6) PFP3
=@ Connection Setings
O3 Fisturex[1]
| @ <Add Fidure>
2T Tasks
£ Task:VTOS Program SPIMMC
@ <Add Task>

4 0x0000000000100000:64 image64.erase.test // Image Erase Test (SDMMC 1:1)

4 0x0000000000100000: 64 image nk.test // Image Blank Test(SDMMC 1:1)

Task

s' C:\ScanWorks\Projects\Zedboard Example Project\Zedboard\6) PFP3\6) PFE3\lmb.test' 0x00
5 B Configuration [VTOS Program SPIMMC] A - -
1= Board
[ Board Initialization ’ nWorks\Projects rd Example Project\Zedboard\6) PFP3\6) PFP3\Imb.test', offset
Pin Configuration b . - -
4.5 Scripts x ) ¢ , throughput of 90.280 KiB/s
=} Processor [2-7020]
< SPIGroup
= SPI0
b SPIl
e QsPl
® SPIFlash:S25FLI56SAGNFIOD
® <Add Device>
£ SDIMMC/SDIO Group 1 c 64 0x00000D0DDD100000: 64 image est // Tmage Erase Test(SDMMC 1:1)
£~ SDMMCD =
® SD/MMC:SDMMC 1:1 L
® <Add Device> F
(i) SDMMCT SDMMC 1:1° Oa 164 0x0000000000100000: 62 _test // Image Blank Test(SDMMC 1:1)
=} & Program Operations s
B Image Erase Test:SP| Flash
age Blank Test:SPI Flash
rogram From File:SPI Flash
age Checksum Test:SPI Flash
age Erase Test:SD Card DSFLOSESACNFIOO! to
age Blank Test:SD Card - 000000
rogram From File:SD Card x 00000
age Checksum Test:SD Card
age Erase Test:QSPlto MMC -
age Blank Test:QSPI to MMC ~ I« i b
| copy |[ Delete || up || Down |

Project: C\ScanWorks\Projects\Zedboard_Example_Project\Zedboard\6) PFP3\6) PFP3\6) PFP3.project (Zyng-7000 Z-7020) [VTOS Program SPIMMC] I

33. In the example above, the flash on the QSPI is programmed over JTAG at a rate of
81.1 KiB/second, the SD/MMC card is programmed over JTAG at a rate of 97.9
KiB/second, and the SD/MMC card is programmed from the Flash device on the
QSPI at a rate of 1.44 MiB/second. Close the Development interface. This concludes
the Debelopment portion of the User’s Guide.

O ScanWorks®
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

Putting it all together — Manufacturing Mode

When all the development is complete and it is time to use PFx on a manufacturing line, it is
desired to run all the actions with a single click. The mechanism for doing this is Sequencing. To

run all the actions as a sequence:

1. In ScanWorks, click on the Sequences tab.

Project: Zedboard Example_Project # RIC-1000 =5 Options | & Licenses || ? Help

Design: Zedboard TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119

Compatible with Design? ves

Projects  Designs  Actions  Sequences Status  Notes  Reports

CZIEEN ScanWorks loaded.

*** | icense Check Out ***

Checked out: PFPT_ARM_ML_SUB
Checked out: PFP_32ARM_DLSUB
Checked out: PFT_32ARM_DLSUB
Checked out: PFT_DDR_32ARM_DLSUB

Project Zedboard_Example_Project loaded

Loading Zedboard. Please wait...

Loading of design Zedboard complete

ScanWorks®

2. Click on the Auto-Create button.

.
Project: Zedboard_Example_Project # RIC-1000 % Options | @ Licenses | ? Help

Design: Zedboard TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119
Compatible with Design? yes

Projects  Designs  Actions  Sequences Status  MNotes  Reports

| (e Brmontin] 2
Project Design Sequence
All_Actions v

p— # [edit notes]

Mapping  Serial Number Status

@ Default || Enter Serial Number

Enable
Rows Sequence Steps Status

SPV1

MMC Programming using Ethernet !
QSPLand MMC over JTAG+QSPI over

MMC

QSPI Programming using Ethernet

MNP Tart and Tina
ScanWorks"
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Quick Start Guide | Using PFx on a Zynq-7000 ZedBoard

3. Hitting the Run button causes all of the actions to be executed.

A subdialog may be active: Closing that dialog will return you to main display.

Abort Status Notes Reports

Mapping Serial Number Status SPV1 running...
@ Default | Enter Serial Number Passed

MMC Programming using Ethernet running...

QSPI and MMC over JTAG+QSPI over MMC running...

Enable -P i

Rows S St Stats
equence Steps s QSPI Programming using Ethernet running...

SPV1

MMC Programming using Ethernet

QSPI and MMC over JTAG+QSPI over MMC
QSPI Programming using Ethernet m
DDR3 Test and Tune

Device Presence Tests - Ethernet Phy+Spi
Flash+MMC Card

Ethernet Loopback Tests

Showing 1 to 7 of 7 entries

ScanWorks®

T Options | & Licenses | ? Help

Project: Zedboard_Example_Project # RIC-1000
Design: Zedboard TCK Frequency: 32.000 MHz
IP Address: 192.168.12.119
Compatible with Design? yes
Projects Designs Actions Sequences Status Notes Reports Pa S S e d
# Edit | #Manage & Precondition B BeslaplVeion/6 ' *
Mapping Name: Gileg LD E TR AT R, Serial Number]
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This concludes the Manufacturing portion of the guide.
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Learn More

If you are interested in our products, please select one of the links below:

ScanWorks Processor-based Flash Programming (PFP) for ARM 32-bit

Processors

ScanWorks Processor-based Functional Test (PFT) for ARM 32-bit

Processors

ScanWorks Processor-based Functional Test DDR (PDTDDR) for ARM

32-bit Processors
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